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Answer KeyClass

7

Touchpad iPRIME (2.2)

 Computer–Hardware Components

OneOne LearnTouch

A.	 1.	 a.	 2.	 a.	 3.	 c.	 4.	 b.	 5.	 a.	 6.	 a.
B.	 1.	 F	 2.	 T	 3.	 F	 4.	 F	 5.	 T
C.	 1.	 output device			   2.	 Storage devices			  3.	 3-D camera
	 4.	 input devices			   5.	 radio frequency

ItLet's Do

A.	 1.	 Motherboard & Disk drive are the hardware attached inside the CPU box.
	 2.	 A smart board is a large interactive screen used in classrooms. You can write on it and 

interact with it using touch or special pens (input). 
	 3.	 Yes, a mouse and a keyboard can be wireless.
	 4.	� A disk drive is used to read from and write to storage disks. Disk drives can be located 

internally within the CPU box or in a separate external enclosure. 
	 5.	 CD- RW stands for Compact Disc Rewritable.
	 6.	 Skylake is Intel’s multi-core chip code which boosts graphics and applications while 

improving battery life in laptops. 
B.	 1.	 The differences between Input and Output Devices are as follows:
		  Input Devices Output Devices

a. �Input devices are devices through 
which a computer accepts data and 
instructions.

a. �Output devices are devices through which 
a computer displays the information and 
result of computation to the user.

b. �Example of the input devices are: 
Mouse, Keyboard

b. �Example of the output devices are:  
Monitor, Printer

	 2.	 The Central Processing Unit (CPU) is a processor and sometimes called a microprocessor.  
It is the computer’s brain as it performs all the calculations and runs programs, managing 
operations and executing the basic instructions that control the computer.  

1.
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	 3.	 Virtual Keyboard is operated by typing on a touch-sensitive surface rather than pressing 
physical keys. It is essentially a software component, as it does not consist of physical parts.  

	 4.	 A port is a slot on the motherboard where you connect various computer components, 
such as a keyboard, mouse, monitor, etc. Three types of ports are: 

	 1.	 Serial Port
	 2.	 Universal Serial Bus (USB) Port
	 3.	 Parallel Port
	 5.	 Switched Mode Power Supply (SMPS) is used to control power supply. It is also known as the 

power supply unit of the computer. It takes Alternating Current (AC) from a source, converts 
it into low voltage Direct Current (DC), and then supplies it to other parts of the computer. 
It has a switching regulator to control the output voltage and an in-built fan to reduce heat. 

C.	 1.	 Akhil can use a graphics tablet to draw directly on the computer screen.
	 2.	 Divya should use a plotter for printing good quality drawings and building construction 

plans.

Higher Order Thinking Skills (HOTS) 

1.	 Memory card 

2.	 �He should use a projector to display the presentation on a big screen and speakers to ensure 
the audience can hear him clearly.

Crack CodeThe

		
P

R

I

M

A

R

M

K

E

A

M

M

T

L

Z

O

S

L

P

O

R

T

M

Y

T

U

L

E

D

O

U

S

U

H

V

O

A S

E O

Z U

V N

I D

M C

E A

O R

C D

U M

M N

N F

R L

E Q

P Q

R R

R R

T F

V P

I D

D A

E T

O A

C B

A D

R S

D E

B S

E O

A R

L Q

O B

T F

O M

B Z

L A

Do it yourself.



3 Touchpad iPRIME (Ver. 2.2)-VII (Answer Key)

 Number System

OneOne LearnTouch

A.	 1.	 c.	 2.	 a.	 3.	 a.	 4.	 a.
B.	 1.	 T	 2.	 T	 3.	 F	 4.	 T	 5.	 F
C.	 1.	 0	 2.	 16	 3.	 10	 4.	 8	 5.	 2

ItLet's Do

A.	 1.	 The Octal Number System has a base of 8 and uses 8 digits: 0 to 7. 

	 2.	 In 1 nibble there are 4 bits.

	 3.	 The total number of digits used in a number system is called its base or radix.

B.	 1.	 A number system is simply a method of counting. There are four types of number systems:

	   (i)  Decimal number system		   (ii)  Binary number system
	 (iii)  Octal number system		  (iv)  Hexadecimal number system
	 2.	 To know the rules to convert a decimal number into a binary number, follow these steps:

		  Step 1	 Divide the decimal number by 2 (the base of the binary number system). 
		  Step 2	 Note down the quotient and the remainder. 
		  Step 3	 Divide the quotient obtained again by 2 and note down the resulting quotient 

and remainder.
		  Step 4		 Repeat the procedure till you reach a quotient less than 2. 
		  Step 5	 Arrange the final quotient and all remainders in reverse order (from bottom to 

top) to get the binary number. We will get our binary number.
	 3.	 The rules to subtract two binary numbers are:

X Y X – Y
0 0 0 – 0 = 0

0 1
0 – 1 = 1

(borrow 1, so that 10 – 1 = 1)
1 0 1 – 0 = 1
1 1 1 – 1 = 0

C.	 1.	 (10111.011)2	 =	 1 × 24 + 0 × 23 + 1 × 22 + 1 × 21 + 1 × 20 

			   =	 1 × 16 + 0 + 1 × 4 + 1 × 2 + 1

			   =	 16 + 4 + 2 + 1 

			   =	 (23)10

2.
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	 2.	 	 0	 10	 10			   10
	 1	 0	 0	 1	 1	 0
–			   1	 1	 0	 1
		  1	 1	 0	 0	 1

_____ Borrow

	 3.	 (a)  	 1	 0	 0	 0
+		  1	 0	 1
	 1	 1	 0	 1

			   (b)	 		  1	 1	 1
		  1	 0	 1	 1
+			   1	 0	 1
	 1	 0	 0	 0	 0

_____ Carry

		  (c)  			   1
	 1	 0	 0	 1
+		  1	 0	 1
	 1	 1	 1	 0

_____ Carry 	 (d)	 		  1	 1	 1
		  1	 1	 1	 1
	 + 	 1	 1	 1	 1
	      1	 1	 1	 1	 0

_____ Carry

		  (e) 

					     1
		  1	 1	 0	 0	 1
	 +	 1	 0	 1	 0	 1
	       1	 0	 1	 1	 1	 0

_____ Carry

	 4.	 (a) 

Hence, (39)10 = (100111)2

2      39 – 4
2      19 – 1
2        9 – 1
2        4 – 1
2        2 – 0
          1 – 0

		  (b)	

Hence, (72)10  
= (1001000)2

2      72
2      36 – 0
2      18 – 0
2        9 – 0
2        4 – 1
2        2 – 0
          1 – 0

	       (c) 

Hence, (128)10  
= (10000000)2

2      128
2        64 – 0
2        32 – 0
2        16 – 0
2          8 – 0
2          4 – 0
2          2 – 0
            1 – 0

		  (d)	

Hence, (55)10 = (110111)2

2      55
2      27 – 1
2      13 – 1
2        6 – 1
2        3 – 0
          1 – 1

		  (e) 

Hence, (173)10 = (10101101)2

2      173
2        86 – 1
2        43 – 0
2        21 – 1
2        10 – 1
2          5 – 0
2          2 – 1
            1 – 0
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D.	 1.	 (10011011)₂
	 2.	 Because there are only four types of number systems.

Higher Order Thinking Skills (HOTS) 

1.	 Born in 9th month → That’s September

	 Date of birth is “10111” in binary

	 Let’s convert 10111₂ to decimal:

	 = 1×24 + 0×23 + 1×22 + 1×21 + 1×20  

	 = 16 + 0 + 4 + 2 + 1 = 23

	 23rd September

2.	 101110₂ to decimal:

	 = 1×25 + 0×24 + 1×23 + 1×22 + 1×21 + 0×20  

	 = 32 + 0 + 8 + 4 + 2 + 0 = 46

	 Amaan’s number: 46
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 Computer Virus

OneOne LearnTouch

A.	 1.	 d.	 2.	 a.	 3.	 b.	 4.	 c.
	 5.	 d.	 6.	 a.	 7.	 a.	 8.	 d.
B.	 1.	 T 	 2.	 T	 3.	 F	 4.	 T	 5.	 F
C.	 1.	 Worm	 2.	 Antivirus	 3.	 Firewall	 4.	 Trojan Horse

ItLet's Do

A.	 1.	 Trojan horse is a type of malware. It conceals itself inside the software that seems 
legitimate.

	 2.	 The use of antivirus program is to identify, prevent, and remove malware from the computer 
system.

	 3.	 Boot sector virus is one of the most destructive types of computer viruses that infects the 
boot sector or the Master Book Record (MBR) of hard disks.

	 4.	 MBR stands for Master Boot Record.
B.	 1.	 Malware is a broad term for various types of malicious software designed to damage, disrupt, 

or gain unauthorised access to a computer system. There are different types of malware 
programs that can affect your computer similarly to viruses. Some of these include worms, 
trojan horse, spywares, ransomware, rootkits and backdoors. 

	 2.	 A computer virus is a ‘piece of code’ or program developed to corrupt the data or program 
files stored on the computer system, whereas a computer worm is a type of malware that 
can replicate itself without any human interaction.

	 3.	 There are several signs that a computer may be infected with a virus: 
	 	 •  �Slowdown: A noticeable decrease in the computer's processing speed. 
	 	 •  �Pop-ups: Unexpected or excessive pop-ups appearing on the system. 
	 	 •  �Crash: Frequent system crashes or Blue Screen of Death (BSOD) errors. 
	 	 •  �Loss of Files: Abrupt or unexplained deletion of files. 
	 	 •  �Unusual Activity of Messages or Programs: Automatic opening or closing of programs, 

unexpected restarts, and strange or unknown windows appearing during boot-up. 
	 	 •  �Unusual Network Activity: Excessive data transfer or unusual network activity even 

when all applications are closed. 
	 4.	 You can protect your PC from viruses by: 
	 i.	 Download only legal softwares.
	 ii.	 Do not open emails or attachments from unknown source. 

3.
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	 iii.	 Do not click on pop-up ads or links from unknown sources. 
	 iv.	 Do not download music, program or games from unknown sources on the Internet. 
	 v.	 Install an antivirus program in your computer system. 
	 vi.	� Scan Pen drives, CDs, and any other external storage devices for viruses before opening 

on computer. 
C.	 1.	 Yes, it is highly likely that Neha’s USB drive contains a virus or malware. Steps Neha should 

take:
	 i.	 Disconnect the USB drive immediately.
	 ii.	 Do not open any unknown files.
	 iii.	 Run a full system scan using antivirus software.
	 iv.	 Use another antivirus to scan the USB drive.
	 2.	 Yes, this is most likely a ransomware attack. Actions Anil should take:
	 i.	 Do not pay the ransom.
	 ii.	 Disconnect the computer from the network.
	 iii.	 Use antivirus or anti-malware software.

Higher Order Thinking Skills (HOTS) 

1.	� Yes, a virus could definitely be the reason why a computer starts behaving strangely. Once a 
virus infects a computer, it can disrupt the normal functioning of the computer's resources, 
such as processing power, memory, and installed programs. 

	 •	 �Slowdown: A noticeable decrease in the computer's processing speed. 

	 •	 �Unusual Activity of Messages or Programs: Automatic opening or closing of programs, 
unexpected restarts, and strange or unknown windows appearing during boot-up. 

	 Types of viruses that could be responsible:

	 i. Program File Virus  		  ii. Boot Sector Virus

2.	� Yes, this is most likely a malware issue, in the form of spyware. Malware is a broad term for 
various types of malicious software designed to damage, disrupt, or gain unauthorised access 
to a computer system. There are several methods of eradication for malware. Some of them 
include: 

	 i.	 Removing the code from an infected file that corresponds to a virus 
	 ii.	 Removing the infected file 
	 iii.	 Quarantining the infected file, which involves moving it to a location where it cannot be 

run 
	 iv.	 Separating all the infected files and applications so that the infection cannot spread further 
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 Ethics and Safety Measures in Computing

OneOne LearnTouch

A.	 1.	 a.	 2.	 c.	 3.	 c.	 4.	 c.	 5.	 b.

B.	 1.	 T	 2.	 F	 3.	 F	 4.	 T	 5.	 F

C.	 1.	 Trademark 	 2.	 Plagiarism 	 3.	 Patent 	 4.	 Phishing	 5.	 Spam

ItLet's Do

A.	 1.	 Software piracy refers to the illegal use, distribution, or duplication of software.
	 2.	 Hacking refers to unauthorised attempts to access a computer system to either destroy it 

or steal important data. 
	 3.	 Patents and Copyright are the two examples of intellectual property rights.

4.
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	 4.	 Two ways to stop Cyberbullying are:
	 (i)	� Be cautious when sharing private information online, as it can be accessed by people 

with malicious intentions. 
	 (ii)	� Avoid disclosing personal details like your address, phone number, or school name to 

unknown individuals online. 
	 5.	 Computer Ethics are the common guidelines that we need to follow while using the 

computer.
B.	 1.	 Patent: A patent gives an inventor exclusive rights to make, use, and sell their invention 

for a specified period. 
		  Trademark: A trademark is a symbol, word, or design legally registered to represent a 

company or product. It helps protect brand names, logos, and product designs. 
	 2.	 The Internet, also called "the Net" or "the Network of Networks," refers to the International 

Network. It is a global network that allows users in various locations around the world to 
communicate and exchange information with one another. 

		  Three disadvantages of Internet:
	 (i)	� Wastage of Time: Excessive use of the Internet can lead to addiction, causing individuals 

to spend excessive amounts of time surfing and engaging in online activities, often to 
the detriment of other responsibilities. 

	 (ii)	� Virus and Spam Attacks: The Internet has increased the prevalence of virus attacks, 
which can result in the loss of data and damage to programs. 

	 (iii)	� Loss of Personal Information: Sharing personal information online can expose 
individuals to the risk of misuse by cybercriminals. 

	 3.	 Three protective measures to avoid Plagiarism:
	 (i)	 We should always mention the source of information.
	 (ii)	 We should rephrase the content as per our requirement to avoid Plagiarism. 
	 (iii)	We should use quotation marks to write the word or lines written by someone else. 
	 4.	 Three ways to stay protective online:
	 (i)	 Be cautious while using your password online. 
	 (ii)	 Don’t entertain strangers or suspicious e-mails. 
	 (iii)	Don’t share your personal details with anyone online.
C.	 1.	 Anju should not click on any links or download any attachments until she is sure the email 

is from a trusted source. Ways how she can identify:
		     i. The email address looks suspicious or unfamiliar

		    ii. It asks for confidential information like passwords or bank details.

		   iii. It includes strange or unknown attachments or links.

	 2.	� Rajiv can check the security of a website by looking at the URL in the browser if it starts with 
https, where the s stands for secure.
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Higher Order Thinking Skills (HOTS) 

	 1.	� Individuals should avoid sharing sensitive personal details. Sharing personal information 
online can expose individuals to the risk of misuse by cybercriminals. Such misuse can lead 
to identity theft and other forms of harm. 

	 2.	� When targeted ads appear based on your conversations or browsing activities, it means that 
devices or apps are collecting and analysing user data. Implications of such a digital presence:

		   i.  �Loss of Privacy – Even private conversations might be used to tailor ads, raising concerns 
about digital eavesdropping.

		   ii.  �Behaviour Tracking – Your preferences, habits, and choices are continuously monitored.

		  iii.  �Data Misuse – The collected data can be shared with third parties or used without clear 
consent.

	  	  iv. �Manipulative Advertising – Ads may try to influence decisions by exploiting personal 
interests or emotions.
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 Spreadsheets—An Introduction

OneOne LearnTouch

A.	 1.	 c.	 2.	 c.	 3.	 d.	 4.	 a.
	 5.	 d.	 6.	 d.	 7.	 b.	 8.	 d.
B.	 1.	 F	 2.	 T	 3.	 F	 4.	 F	 5.	 F
C.	 1.	 Name box			   2.	 Title	 3.	 Quick Access
	 4.	 Formula			   5.	 Worksheet

ItLet's Do

A.	 1.	 Excel is the most commonly used interactive spreadsheet program that allows us to perform 
mathematical calculations, analyse data, and store data in tabular format. 

		  Formatting Features: Excel allows to use formatting features to improve the look and feel 
of the data. 

	 2.	 Ribbon is like a strip that has various tabs such as Home, Insert, Page, Layout, Formulas 
and Data. These tabs consist of different groups that contain related commands.

	 3.	 The currently selected cell that appears highlighted with green border is an active cell.

	 4.	 Name box is a box located on the left side of the excel window, just below the Ribbon. The 
address of the active cell is displayed in this box.

B.	 1.	 Formula bar is a text box located on the right side of the Name box that allows you to 
enter and edit formulas and perform calculations on your worksheet data. It is also used 
for entering and editing the contents. 

	 2.	 A worksheet is the main working area in excel window where we can enter data, whereas 
a workbook is a collection of different worksheets.

	 3.	 The row heading is the grey-coloured number (1,2,3…etc) located in front of each row in 
the worksheet.

	 4.	 To create a new workbook in MS Excel 2016, follow these steps:

	 Step 1  Click on File tab to open the Backstage view.

	 Step 2  Click on the New option.

	 Step 3  Click on Blank workbook in the Available Templates list. 

	 A new workbook will be created.
C.	 1.	� In a spreadsheet program like Microsoft Excel, data entered into cells can be of various data 

types, including:

5.
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		  i.  �Numbers: Numbers include the digits (0–9) and their various combinations. All types of 
calculations can be done on numbers.  

		  ii. Date: Date type is used to enter the date in different formats. 

	 2.	� In a spreadsheet, column headers like A, B, C, D... are part of the spreadsheet’s structure, 
not editable cells.

Higher Order Thinking Skills (HOTS) 

a.	 S

b.	 P, after clicking File tab, select Save As option to save your file.

c.	 Double-click

d.	 Status bar

Crack CodeThe
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 More on Spreadsheets

OneOne LearnTouch

A.	 1.	 d.	 2.  a.		  3.  a.		  4.  c.  		  5.  b.		  6.  a.

B.	 1.	 Insert	 2.  Cell Styles	 3.  Select All	 4.  Merge & Center

C.	 1.	 F	 2.  T		  3.  F  		  4.  T		  5.  T

ItLet's Do

A.	 1.	 Yes, we can unmerge the merged cells. The command which is used to unmerge the cells 
is Unmerge cells command.

	 2.	 Copy command is used to copy the contents to the new location, and it also exists in its 
original location. 

	 3.	 Wrap text feature of MS Excel allows user to display multiple lines of text inside a cell.

B.	 1.	 Steps to wrap the text are:

		  Step 1  Select the cell in which you want to wrap the text. 

		  Step 2  Click on the Wrap Text command in the Alignment group under the Home tab. 

	 2.	 Steps to change row height and column width are:

		  Step 1  Select the column(s) or row(s) whose width or height you want to change. 

		  Step 2  Click on the Format command in the Cells group under the Home tab. 

		  Step 3  �Select the Column Width or Row Height under Cell Size section from the drop-down 
list. A Column width or Row height dialog box will appear.

		  Step 4  Type the desired value in the Column Width or Row Height text box. 

	 3.	 Steps to apply cell border are:

		  Step 1  Select the cell or cell range where you want to add or change a border.

		  Step 2  �Click on the arrow next to the Borders command in the Font group under the Home 
tab. 

		  Step 3  �Select the desired border from the drop-down list. Alternatively, you can select the 
More Borders option to customise the border. 

 	 4.	 If we type 12*(10+5)-5 in cell A5 and press the Enter key, then the result in cell A5 will be 
175.

		  When performing calculations using a formula, Excel follows certain rules of precedence: 

•	 Excel calculates expressions within parentheses ‘(‘ , ’)’ first. 

6.
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•	 Excel calculates multiplication and division before addition and subtraction. 

•	 Excel calculates consecutive operators with the same level of precedence from left to 
right. 

		  For example: 

		  12*(10+5)-5

		  = 12*15-5

		  = 180-5

		  = 175

		  Here is a justification of the answer:

		  We multiply 12 by 15, which is 180.

		  We then subtract 5 from 180, which is 175.

		  Therefore, the result of the expression is 175

C.	 1.	� Sonia should use Wrap Text. Multiple lines of text inside a cell can be displayed using the 
Wrap Text feature. Wrapping text in a cell does not affect other cells. 

	 2.	� If Anaya forgot to include marks for a subject, she can easily insert a new column or row in 
her spreadsheet. To insert a row/column in a worksheet, follow these steps: 

		  Step 1  Select the row/column heading where you want to insert a new row. 

		  Step 2  Click on the Insert command in the Cells group under the Home tab. 

		  Step 3  Select the Insert Sheet Rows/Columns option from the drop-down list.  

Higher Order Thinking Skills (HOTS) 

1.	 Click on the row heading to select the entire row.

2.	 a.	 To merge cells, follow these steps: 

		  Step 1	 Select two or more adjacent cells that you want to merge. 

	 	 Step 2	� Click on the Merge & Center command in the Alignment group under the Home tab. 
The cells will be merged in a row or column, and the cell content will be centered 
in the merged cell. 

	 b.	 Jaspreet (Row 2) → formula in J2: =SUM(E2:I2)

		  Ahmed (Row 3) → formula in J3: =SUM(E3:I3)

		  Jasper (Row 4) → formula in J4: =SUM(E4:I4)

		  Priya (Row 5) → formula in J5: =SUM(E5:I5)

		  Rajveer (Row 6) → formula in J6: =SUM(E6:I6)
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Worksheet–1
(Based on chapters 1 to 6)

A.	 1.	 Compact Disc (CD) drive 		  Digital Versatile Disc (DVD) drive
	 2.	 Audio				    PS/2
	 3.	 Octal				    Binary
	 4.	 Jerusalem				    Cascade
	 5.	 Cyberbullying 				   Plagiarism
	 6.	 Title Bar				    Ribbon

B.	 1.	 All the physical components of a computer system are called Hardware.
	 2.	 The total number of digits used in a number system is called its base or radix.
	 3.	 Antivirus software is a program designed to identify, prevent, and remove malware from 

your computer. 
	 4.	 Cyber crime can be defined as criminal activities carried out by means of computers or the 

Internet. 
	 5.	 A cell range is a collection of two or more cells.
	 6.	 AutoFill feature automatically fills a series of data in our worksheet.
C.	 1.	 CPU	 2.	 SMPS	 3.	 Webcam	 4.	 Byte
	 5.	 Malware	 6.	 Digital Footprints	 7.	 Title Bar	 8.	 equal (=) sign
D.	 1.	 Projector	 2.	 Graphic Tablet		  3.	 SMPS
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Test Sheet–1
(Based on chapters 1 to 6)

Section A
A.	 1.	 a.	 2.	 a.	 3.	 c.	 4.	 b.	 5.	 a.
	 6.	 d.	 7.	 c.	 8.	 d.

B.	 1.	 input devices			   2.	 8	 3.	 Antivirus
	 4.	 Spam			   5.	 Formula	 6.	 Cell styles

C.	 1.	 F	 2.	 T	 3.	 F	 4.	 T	 5.	 F	 6.	 F

Section B
A.	 1.	 Yes, mouse and keyboard can be wireless.
	 2.	 There are 4 bits in 1 nibble.
	 3.	 The term "eradicating a virus" refers to the process of completely removing a virus from 

an infected computer, ensuring that the system is clean and secure. 
	 4.	 Cyberbullying is the use of electronic media such as smartphones, computers and tablets 

to harass or attack a person. It is also known as online bullying.
	 5.	 The currently selected cell that appears highlighted with green border is an active cell.

B.	 1.	 Switched Mode Power Supply (SMPS) is a hardware component of the computer used to 
control the power supply. It is also known as the power supply unit of the computer. It 
takes the Alternating Current (AC) from a source and converts it into low voltage Direct 
Current (DC) and then supplies it to other parts of the computer system. 

	 2.	 =	 1 × 23 + 1 × 22 + 1 × 21 + 1 × 20

		  =	 8 + 4 +2 + 1
		  = 15
		  (1111)2= (15)10
	 3.	 A computer virus is a ‘piece of code’ or program developed to corrupt the data or program 

files stored on the computer system. Two types of computer virus are Macro Virus and 
Boot Sector Virus.

	 4.	 Plagiarism is the act of taking someone else's work and presenting it as your own without 
giving proper credit to the original author. Two ways to prevent Plagiarism:

	 (i)	 We should always mention the source of information.

	 (ii)	 We should use quotation marks to write the word or lines written by someone else.

	 5.	 A worksheet is the main working area in excel window where we can enter data. A workbook 
is a collection of different worksheets.
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 Database and DBMS—An Introduction

OneOne LearnTouch

A.	 1.	 b.	 2.	 a.	 3.	 a.	 4.	 c.	 5.	 d.

B.	 1.	 T	 2.	 F	 3.	 F	 4.	 F

C.	 1.	 relation	 2.	 fields	 3.	 primary 	 4.	 Status bar	 5.	 Navigation 

ItLet's Do

A.	 1.	 Primary Key is a unique field by which the records are uniquely identified in a table.
	 2.	 The final result of the manipulated data that comes from tables or queries in DBMS is 

known as a report.
	 3.	 A query is the most powerful object of database. It helps us to retrieve information from 

a table based on some criteria or condition.
	 4.	 A form is a database object used to create a user interface to enter or update a record in 

a table that is connected to it.
B.	 1.	 Steps to add record in Database are: 
		  Step 1  Open the required table in Datasheet view. 
		  Step 2  Place the pointer and start typing where you want to add the new record. 
		  Steps to delete a record in Database are: 
		  Step 1  Open the required table in Datasheet view. 
		  Step 2  Right-click on the row header of the record which you want to delete. 
		  Step 3  Select the Delete Record option from the context menu. 
	 2.	 Four data types of MS Access are:
	 1.  Short Text			   2.  Hyperlink		  3.  Number	 4.  AutoNumber
C.	 1.	 Advantages of a Database Management system are:
	 (i)	 It minimises the duplication of data by integrating and sharing the data files.
	 (ii)	 It saves the storage space.
	 (iii)	All the users are provided with some access rights or privileges and permissions.
	 (iv)	The files can be easily updated whenever any changes are made.

	 2.	 There are two types of views in MS Access: Datasheet view and Design view. We can switch 
between these two views by clicking on the arrow of the View command in the Views group 
under the Home tab.

		�  In Datasheet View, by default, Access names the first field ID and sets it as the Primary Key 
with the AutoNumber data type, which means Access will automatically create a unique 
number for each record.

7.



 Touchpad iPRIME (Ver. 2.2)-VII (Answer Key)18

		  In the Design View, the records are not visible. We can only see the field names along with 
their data types.

	 3.	 Following are the rules we should remember while writing field names: 
	 (i)	 Field name can be up to 64 characters long. 
	 (ii)	� Field name can include any combination of letters, numbers, spaces, and special characters 

except a period (.), an exclamation mark (!), an accent grave (‘) and brackets ([ ]). 
	 (iii)	Field name cannot begin with the leading spaces. 
	 (iv)	Field name cannot include a double quotation mark (“).
D.	 1	 Ranjeet can use the Sort feature in Microsoft Access to view records in a sequential manner. 

The Sort feature allows users to arrange data in ascending (A-Z or 0-9) or descending (Z-A 
or 9-0) order based on the values in one or more fields.

	 2.	 Jennifer is most likely to use a Relational Database to track her monthly expenses. A relational 
database allows data to be organised in tables with rows and columns, making it easier to 
store, retrieve, and manage data efficiently.

Higher Order Thinking Skills (HOTS) 
	 1.	 To retrieve information about students who scored above 90%, the Query object in Microsoft 

Access should be used. It helps in retrieving information from a table based on some criteria 
or conditions. 

	 2.	 In Microsoft Access 2016, the student information should be typed directly into the Datasheet 
View of the table. 
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Do it yourself.

 More on Access

OneOne LearnTouch

A.	 1.	 a.	 2.	 b.	 3.	 c.	 4.	 c.
B.	 1.	 F	 2.	 F	 3.	 T	 4.	 T	 5.	 T
C.	 1.	 Title, logo	 2.	 Layout view	 3.	 Relationship	 4.	 Run 	 5.	 Foreign key

ItLet's Do

A.	 1.	 A form is a database object used to add, edit and display data from a table in a user-friendly 
manner. 

	 2.	 A report is used to organise and present data in a user-friendly format so that it can be printed.
	 3.	 The three main views in which a form can be displayed are: Form view, Design view and 

Layout view.

B.	 1.		 A query is one of the most important tools. It helps to find, filter, and analyse data from 
the database. Whereas a report in MS Access is a feature which allows us to organise and 
present our data in a user-friendly format so that it can be printed.

	 2.	 To create a report, follow these steps: 
	 Step 1	� Open the desired table for which you want to create a report.
	 Step 2 	 Click on the Report command from Reports group under Create tab.
	 The report of the table, which is open will be created.

	 3.	 Field, table, sort and criteria are the parameters displayed at  the bottom of the Query 
window while creating a query.

C.	 1.	 Neil should use the Design tab in Microsoft Access to add a logo and title to the registration 
form. Under the Header/Footer group of the Design tab, he can find the commands.

	 2.	 In the 'Orders' table, the corresponding field should also be named 'CustomerID', but it 
should be defined as a foreign key.

		  This is because the primary key (CustomerID) in the 'Customers' table uniquely identifies 
each customer, and by placing the same field in the 'Orders' table as a foreign key.

8.
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Higher Order Thinking Skills (HOTS) 
1.	� The default view in which a form appears when it is first created in Microsoft Access is the Layout 

View.

2.	 The type of form used for viewing multiple book records at once is called a Multiple Items Form.
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Do it yourself.

 Lists and Tables in HTML

OneOne LearnTouch

A.	 1.	 a.	 2.	 c.	 3.	 c.	 4.	 c.	 5.	 b.
B.	 1.	 T	 2.	 F	 3.	 F	 4.	 F	 5.	 T
C.	 1.	 TYPE, START			   2.	 disc	 3.	 <TH>
	 4.	 border-style 			   5.	 Table Data 

9.
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ItLet's Do

A.	 1.	 The <UL> tag is used to define an unordered list with any of the bullets using the TYPE 
attribute or list-style-type property.

	 2.	 <OL TYPE="a">
B.	 1.	 The border-spacing property is used to specify the space between the borders of adjacent 

cells. For example: 
		  <style>
		  table, th, td 

		  { 

		  border:2px; 

		  border-style:solid; 

		  border-color:green; 

		  border-spacing:15px; 

		  }

		  </style> 

	 2.	 table {
		  border: 3px solid red;

		    border-spacing: 10px;

		    padding: 15px;

		  }

	 3.	 The ROWSPAN attribute in HTML is used with the <td> or <th> tag inside a table. The 
ROWSPAN attribute applies when a cell is extended for more than one row, that is, the cell 
spans for 2 or more rows instead of 1. Example: 

		  <table border="1">

		    <tr>

		      <th>Name</th>

		      <th rowspan="2">Class</th>

		      <th>Subject</th>

		    </tr>

		    <tr>

		      <td>Ravi</td>

		      <td>Science</td>

		    </tr>

		  </table>
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C.	 1.	 Nisha should use the rowspan attribute.
	 2.	 Rakesh should use the background-color property.

Higher Order Thinking Skills (HOTS) 
1.	 <HTML>

	 <HEAD>

	   <TITLE> Key Features of HTML </TITLE>

	 </HEAD>

	 <BODY>

	   <B>Key Features of HTML</B><BR>

	 Some of the important features of HTML are:

	   <UL>

	     <LI>It is a platform-independent language.</LI>

	     <LI>It allows us to build tables.</LI>

	     <LI>It allows us to add a link to the web page.</LI>

	     <LI>It is not a case-sensitive language.</LI>

	     <LI>It is a very easy and simple language.</LI>

	     �<LI>It provides a flexible way to design web pages along with the 
text.</LI>

	   </UL>

	 </BODY>

	 </HTML>

2.	 Do it yourself.

Crack CodeThe

	 1.	 Ordered List			   2.	 <DL>	 3.	 <TR>
	 4.	 width			   5.	 padding

Do it yourself.
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 More on Html

OneOne LearnTouch

A.	 1.	 c.	 2.	 c.	 3.	 c.	 4.	 a.
	 5.	 c.	 6.	 b.
B.	 1.	 F	 2.	 T	 3.	 F	 4.	 T	 5.	 F
C.	 1.	 Password			   2.	 Method	 3.	 type
	 4.	 Reset	  		  5.	 select, option

ItLet's Do

A.	 1.	 Alt specifies the alternate text to be displayed in the web browser, if the provided image 
is not found. 

	 2.	 <!DOCTYPE HTML> 
		  <HTML> 

		  <HEAD> 

		  <TITLE>Audio</TITLE> 

		  </HEAD> 

		  <BODY> 

		  <AUDIO SRC="TalkNext.mp3" CONTROLS AUTOPLAY> 

		  </AUDIO> 

		  </BODY> 

		  </HTML> 

	 3.	 RADIO: This value is used to create a radio button control. A radio button control is used 
to select only one option from a set of options. 

		  CHECKBOX: This value is used to create a checkbox control. A checkbox control allows us 
to select multiple options from a set of options. 

	 4.	 Five different values that can be assigned to the TYPE attribute of the <INPUT> tag in HTML 
are: TEXT, RADIO, CHECKBOX, RESET, PASSWORD.

B.	 1.	 The control attribute allows users to gain control over how the video is played.
	 2.	 To open a link in a new browser window or tab using HTML, you use the target="_blank" 

attribute in the Anchor tag.
		  WIDTH specifies the width of the image in the web page. For example, 
	 	 <IMG SRC="lily.jpg" WIDTH="50 %">

10.
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	 3.	 HTML provides a feature to display more than one web page on a single screen of the web 
browser. These web pages are actually displayed using frames. Frames are the different 
sections or parts of a web page. 

	 4.	 A checkbox is like a toggle switch where users can select a desired choice by clicking on 
the check box. You can assign different values to checkboxes using the value attribute. 

		  <form>
		    <input type="checkbox" name="subject" value="Math"> Math<br>

		    <input type="checkbox" name="subject" value="Science"> Science<br>

		    <input type="checkbox" name="subject" value="English"> English<br>

		  </form>

C.	 1.	 You can use internal links (<a href="#section">) to navigate within a course, and external 
links (<a href="https://example.com" target="_blank">) to connect to outside resources.

	 2.	 Use the <iframe> tag to display two web pages side by side. One page can include a list 
and radio buttons, while the other can show checkboxes. This allows users to view and 
interact with both pages on a single screen.

		  Web Page 1 – Using a List with Radio Buttons:
		  <!DOCTYPE html>
		  <html>
		  <head>
		    <title>Course Options - Radio Buttons</title>
		  </head>
		  <body>
		    <h1>Select Your Preferred Course Type</h1>
		    <ol>
		      <li>
		        <input type="radio" name="course" value="online" id="online">
		        <label for="online">Online Course</label>
		      </li>
		      <li>
		        <input type="radio" name="course" value="offline" id="offline">
		        <label for="offline">Offline Course</label>
		      </li>
		      <li>
		        <input type="radio" name="course" value="hybrid" id="hybrid">
		        <label for="hybrid">Hybrid Course</label>
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		      </li>
		    </ol>
		  </body>
		  </html>
		  Web Page 2 – Using a List with Checkboxes:
		  <!DOCTYPE html>
		  <html>
		  <head>
		    <title>Resources - Checkboxes</title>
		  </head>
		  <body>
		    <h1>Select the Resources You Need</h1>
		    <ul>
		      <li>
		        �<input type="checkbox" name="resources" value="ebooks" 

id="ebooks">

		        <label for="ebooks">E-books</label>
		      </li>
		      <li>
		        �<input type="checkbox" name="resources" value="tutorials" 

id="tutorials">

		        <label for="tutorials">Tutorials</label>
		      </li>
		      <li>
		        �<input type="checkbox" name="resources" value="webinars" 

id="webinars">

		        <label for="webinars">Webinars</label>
		      </li>
		    </ul>
		  </body>
		  </html>

Higher Order Thinking Skills (HOTS) 
    <!DOCTYPE html>

    <html>
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    <head>

      <title>NEWS</title>

    </head>

    <body>

      <h1>School News Bulletin</h1>

      <marquee direction="right">

        * Dance competition will be held on Monday.

      </marquee>

      <marquee direction="right">

        * You have to submit your entries for the school magazine by Friday.

      </marquee>

    </body>

    </html>

Crack CodeThe

	 1.	 Yes, in HTML5, you can embed a video that plays with its audio muted by default. This is 
achieved using the <video> element with the muted attribute. 

	 2.	 <!DOCTYPE html>
		  <html>

		  <head>

		    <title>Harmful Effects of Plastics</title>

		  </head>

		  <body>

		    <h2>Select Harmful Effects of Plastics:</h2>

		    <form>

		      <input type="radio" name="effect" value="Pollution"> Pollution<br>

		      �<input type="radio" name="effect" value="Pleasant Weather"> 
Pleasant Weather<br>

		      �<input type="radio" name="effect" value="Endangering Wildlife"> 
Endangering Wildlife<br>

		      <input type="radio" name="effect" value="Toxicity"> Toxicity<br>

		      <input type="radio" name="effect" value="Greenery"> Greenery<br>

		    </form>

		  </body>

		  </html>
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	 3.	 Yes, the HTML code will still execute without error, even if the image file image.jpg is missing 
or deleted.

		  The image will not be displayed on the web page because the file image.jpg is not found.
		  Instead, the browser will show the alternate text provided by the alt attribute.

Do it yourself.
Worksheet–2

(Based on chapters 7 to 10)

A.	 1.	 The software required to store, retrieve, and manage data in a database is known as a 
Database Management System (DBMS). 

	 2.	 Datasheet view is the default view of the table. It shows all the fields and the records as 
entered by the user.

	 3.	 Query allows user to retrieve information from a table based on some criteria or condition.

	 4.	 A form is a database object used to create a user interface to enter or update a record in 
a table that is connected to it.

	 5.	 This type of list is used to display the items in a sequential manner. <OL> tag is used to 
create an ordered list.

	 6.	 Internal linking connect one page of a website to another page on the same site. 

B.	 1.	 Microsoft Access	 ORACLE

	 2.	 Title Bar	 Ribbon

	 3.	 Short Text	 Hyperlink

	 4.	 Select	 Parameter

	 5.	 Type	 Start

	 6.	 Behaviour	 Direction

C.	 1.	 Field Properties Pane

	 2.	 Design

	 3.	 Date and Time

	 4.	 Report

	 5.	 Ordered List

	 6.	 <TR>

	 7.	 BGCOLOR

	 8.	 ALINK
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	 9.	 TYPE

	 10.	 <TEXTAREA>

D.	 1.	 <INPUT TYPE="RADIO">

	 2.	 <INPUT TYPE="BUTTON"> 

	 3.	 <SELECT>

Test Sheet–2
(Based on chapters 7 to 10)

Section A
A.	 1.	 a.	 2.	 c.	 3.	 b.	 4.	 a.	 5.	 c.	 6.	 c.

B.	 1.	 List	 2.	 Relationship			   3.	 Run	 4.	 Ordered list

	 5.	 <A>	 6.	 <SELECT>

C.	 1.	 F	 2.	 T	 3.	 T	 4.	 F	 5.	 F	 6.	 T

Section B
A.	 1.	 Primary key is a unique field by which the records are uniquely identified in a table.
	 2.	 Yes, we can add an image as background in a form of MS Access. Format tab is used to 

add an image in a form of Access.
	 3.	 <CAPTION> tag is used for defining the title of the table.
	 4.	 BORDER specifies the thickness of the border surrounding the image.
B.	 1.	 Advantages of Database system are:
	 (i)	 It minimises the duplication of data by integrating and sharing the data files.
	 (ii)	 It saves the storage space.
	 (iii)	All the users are provided with some access rights or privileges and permissions.
	 (iv)	The file can be easily updated whenever any changes are being made.

	 2.	� A form is a database object used to create, edit and display data stored in tables in a user-
friendly manner. Three main views in which a form can be displayed are:

	 (i)	 Form View
	 (ii)	 Design View
	 (iii)	Layout View 

	 3.	 <html>
		  <head>

		  </head>

		  <body>
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		  <table border="1">

		  <tr>

		  <th rowspan="2"> Name</th>

		  <th rowspan="2"> Subject</th>

		  <th colspan="2"> Marks</th>

		  </tr>

		  <tr>

		  <th>Term 1</th>

		  <th>Term 2</th>

		  </tr>

		  <tr>

		  <td>Chirag</td>

		  <td>English</td>

		  <td>79</td>

		  <td>87</td>

		  </tr>

		  <tr>

		  <td>Divya</td>

		  <td>Math</td>

		  <td>88</td>

		  <td>83</td>

		  </tr>

		  </table>

		  </body>

		  </html>


